
Welcome to WinCharging!
Welcome to WinCharging ... the best idea yet for managing your credit card accounts.

This is WinCharging's MeFirst! Help file devoted entirely to acquainting you with your new 
program.    It's set up like a book.    To read it, click the >> Browse button above.

Every click brings up a new chapter that's short and easy to read, and each comes with 
pictures and diagrams that simplify the introductory process.    Many of the pictures contain 
hot spots that you can click on for even more information.

For maximum benefit, run WinCharging while viewing this Help file.    When you finish a 
chapter in here, <Alt>+<Tab> to WinCharging and perform the next step in the setup 
procedure.    When you've accomplished that, <Alt>+<Tab> back here and read the next 
chapter.    After you've finished, you'll be ready to launch WinCharging solo.

Once you feel comfortable with WinCharging, you can delete this Help file from your hard 
disk to save space.    To do so, open the File Menu and click on Maintenance.    Highlight the 
Delete Help File command and click on MeFirst! Help.    Confirmation is required.

Don't forget, this is just the introductory Help file.    WinCharging's standard Help file covers 
every facet of the program, is online and context-sensitive, contains a complete Index, and 
can also be read much like a book.

Now ... get your favorite refreshment, sit down, relax, kick your shoes off, and get ready to 
learn all about WinCharging.



How WinCharging Works
You're probably familiar with some of the many checking programs on the market in which 
each check or deposit is entered as an individual record.    When the balance statement 
arrives, each of the records that appears on the statement is cleared.

WinCharging functions very much like that.    Every credit card receipt, be it a charge or a 
refund, is entered as a separate record.    When a card issuer sends you a billing statement, 
you mark each of the records that appears on the statement paid.

If you don't pay an account's new balance in full every billing period, you'll need to employ the 
pay down method of accounting, described in a later topic.

But you can do a great deal more than simply enter and clear records, however.    
WinCharging offers a wide variety of analytical tools that are easy to use and easy to 
understand.    For example ...

Report Generator lets you graph, display, or print reports.    Monitor helps you keep tabs 
on your credit limits as well as any target amounts you may have defined, and Credit Card 
Activity displays year-to-date graphs of your accounts.

Find searches your database for records that match any number of specified parameters, 
while Program Log displays WinCharging's internal messages and even lets you create 
reminder messages for yourself.

If your credit cards come up missing, Lost or Stolen tells you the phone numbers you need 
to call to notify your card issuers.    Grid Work affords you the opportunity to view your 
entire receipts file in a single gridded form.    And there's still more.    WinCharging is 
delightfully customizable, easy to use, and incredibly powerful.

In the following chapters, you'll learn the basics of how to enter your credit card names, 
create your charge and refund records, and mark those records paid.    Please take the time 
to read through this short Help file.    It provides you with the foundation necessary to fully 
realize WinCharging's potential.

If you don't have WinCharging running, take a moment to <Alt>+<Tab> back to Program 
Manager and start it now.    If you haven't run it yet, WinCharging will display the User Name 
form.    After you fill that in, WinCharging asks if you would like to see the MeFirst! Help file 
(this file).    Reply yes, and WinCharging will bring MeFirst to the front for you automatically.

Tip

Protect the information you enter by clicking the Save button on the Button Bar before you 
switch from WinCharging to the MeFirst! Help file (or to any other window for that matter).    
The Save button tells WinCharging to write your data to the hard disk immediately.



The Center of Attention
Most Windows programs that have more than one form generally have a form that is the 
focus of the entire program.    WinCharging's focal point is the Outstanding Amounts window.

Outstanding Amounts does much more than display your credit card names and their 
outstanding amounts.    It allows you fast access to a variety of WinCharging's other forms 
and functions.    For example, to find out what a card's account number is, double-click the 
form to display account numbers.    Or, if you want to get a quick look at a card's year-to-
date activity, just double-click the account's name.

Some of the forms accessible from Outstanding Amounts are Credit Card Data, Details of 
Outstanding Bills, Pay Bills, and Issuer Information.    These and several other windows are 
covered in the following chapters.



New Account Row

A new account row consists of a Pay Bills button on the left, a Credit Card Data button on the
right, and space for the account name and its outstanding amount.



Add Button

Adds an extra row of account buttons to the form for another credit card entry.    If you have 
unused rows on the form when you exit WinCharging, they are automatically removed.



Close Button

Closes the Outstanding Amounts window.    You can re-open it using the Launch Menu's 
Outstanding Amounts command.



Pay Bills Button

Launches Pay Bills, if the associated account uses the standard accounting method, or the 
Make PDM Payment form, if the button's account uses the pay down method.



Credit Card Data Button

Opens Credit Card Data or Issuer Information for the associated account.    Click to open the 
former.    Press <shift> + click to open the latter.    Also called an account button.



Outstanding Amounts (Form)

You can easily refer to your account numbers by double-clicking any portion of the form (or 
pressing <F5>).    This is handy when you need to identify an account by number rather 
than name.



Credit Card Names

This side of the display shows your account names.    Double-click a credit card name to 
display a graph of the account's year-to-date activity.



Credit Card Amounts

The right side of the display shows the outstanding amounts for your accounts.    Double-
click an amount to open that card's Details of Outstanding Bills.



Credit Card Data
Before you can enter your receipt records, WinCharging needs to know which credit card 
accounts you want it to manage.    You create and maintain your account information in the 
Credit Card Data window.

Although you can open Credit Card Data from the Launch Menu, it's a lot easier to click one of the 
buttons on the right side of Outstanding Amounts as shown below.

Although Credit Card Data requires only the account name, you should fill in all of the fields.  
The more information you give WinCharging, the more it can do for you.

Take a moment now to switch back to WinCharging and fill in a Credit Card Data 
window for each of your credit cards.    Remember, if you need more account rows,
click the Add button.    Then return to this Help file.

Note:    WinCharging manages up to twelve credit cards.    The shareware version works on a single
userfile (database).    The registered version (also called the deluxe edition) allows you to create 
any number of userfiles.

Now that you've entered your credit card names, you could start creating your charge 
receipts records.      To really get off on the right foot, however, you should learn about the 
Issuer Information form and become acquainted with the Category Editor.    They're 
described in the following chapters.





Credit Card Name

The name you wish to use to refer to this account.    Required.



Credit Card Number

Highly recommended, the account number is often the only way to identify a charge receipt.



Credit Alarm

If checked, WinCharging warns you upon shutdown when you exceed your credit limit.



Target Alarm

If checked, WinCharging tells you upon shutdown when you achieve your target amount.



Number of Cards

Represents the total number of cards associated with the named account.



Account Row

Made up of a button on either side and a display area for the name of an account and its 
outstanding amount.



Delete Button

Removes the displayed account from the Outstanding Amounts window and renders all 
records pertaining to that account inactive.



Issuer Information Button

Opens the Issuer Information window for the named account.



Target Start and End Dates

The start and end dates of the period for which WinCharging is to tally an account's records 
that apply toward the target amount.



Close Button

Closes the Credit Card Data window.



Reset Button

Resets all fields on the form to their original values.



Target Amount

Represents the amount you wish to spend, either as a limitation or as a goal, during the 
period defined by the start and end dates.



Target Calculator Button

Opens the Target Calculator.    Some car manufacturers offer rebates of 5%, up to a 
maximum of $700, on what you spend.    The Target Calculator calculates how much you 
have to spend to get the maximum allowed.



Update Button

Updates the credit card database with any new information entered into the window.



Issuer Information
The Issuer Information window manages the names, addresses, and phone numbers of the 
companies that issued you your credit cards.    You'll find this information on your billing 
statements and account agreements.

Most credit card companies require prompt notification if your cards are lost or stolen.    
When you fill out Issuer Information, WinCharging can help you should you find yourself in 
one of these unfortunate situations.

The Lost or Stolen window displays, among other things, the phone numbers you need to 
call to notify your card issuers that your credit cards have been lost or stolen.    It even prints
the letters many issuers require for proper notification.

Once you've entered the issuer information for all of your accounts you can check it by 
opening Lost or Stolen.    You'll find it on the Options Menu.

Some of the data entered in this and the Credit Card Data windows change periodically.    Be 
sure you keep your information current.

It's time to switch back to WinCharging and fill in an Issuer Information form for 
each of your accounts.    To open it, hold down <shift> and click the appropriate 
account button on the right side of Outstanding Amounts.    When you're finished 
return here and read the next chapter on the Category Editor.



Lost Phone Number

The phone number you have to call should your credit cards get lost or stolen.



Close Button

Closes the Issuer Information window.



Reset Button

Resets all of the fields on the form to their original values.



Update Button

Updates the credit card database with the current issuer information.



Credit Card Name

Double-click the account name to open the Credit Card Data window.



Category Editor
Categories enhance WinCharging's processing power and afford you a better idea of how 
well you're utilizing your credit.    Look at the Category Editor form below.

Notice that you can combine your household categories with those you use in your home 
office.    All of your categories should be entered in the Category Editor.    These categories 
constitute your permanent category list.    This is the list WinCharging displays whenever you
use a function that requires a category entry.

To add new categories, click the Add button.    Make sure you spell your entry correctly 
because WinCharging uses your permanent category list for reference when it checks the 
upper and lower case of your manual entries.

For example, if you enter gasoline manually in a category field, WinCharging looks in your 
category list to find Gasoline and replaces your manual entry with the category item found 
on your list.

If you want to change the spelling of a category entry or its tax status, simply highlight the 
item you want to correct and click the Change button.

Be sure you use the Category Editor to make any changes to your category list.    If you make
a spelling change, for instance, WinCharging automatically updates every record in your file. 
It's a lot easier than changing every occurrence in your database yourself.

Now would be a good time to create your category list.    You'll find the Category 
Editor listed on the Options Menu.    When you're finished, please return here.

Okay, you have the beginnings of a database.    You've already entered your credit card data 
and issuer information, and you just created your category entries.



So, if you have any charge receipts lying around, gather them up now.    It's time to learn 
how to use the New Receipts window.



New Category Form

Double-click form to switch between standard and large font size.



Close Button

Closes the Category Editor window.



Add Button

Allows you to add a new category to your permanent category list.



Category Editor Form

Double-click to alternate between standard and bold type in the category list box.



Category List

Displays your permanent category list.



Change Button

Allows you to change the highlighted category entry or its tax-related status.



Delete Button

Lets you delete the highlighted category entry.    Confirmation is required.



Enter Button

Puts the new category entry on your permanent category list.



Cancel Button

Cancels the New Category function and closes the window.



Tax Item Checkbox

If checked, tells WinCharging that the category is tax-related.



New Receipts
As its name implies, it is in this window that you enter the information found on those tiny 
scraps of paper you're given when you make credit card purchases.

    You can open New Receipts from the Launch Menu or the Button Bar.

Most of the field entries are straightforward in New Receipts, but a word to the wise is 
offered:    If you haven't entered the account numbers of your credit cards in the Credit Card 
Data window, go back and do so now.    They're especially handy in New Receipts because 
account names are frequently illegible on or missing from the receipts you get from 
merchants.

If a receipt fails to show the account name, open the drop-down list (as shown above).    
You'll see the names of your accounts.    Press <F5> and the account names change to their 
respective account numbers, if you've entered them.    Select the number that matches the 
one on the receipt and press <enter>.

To change the selected account number back to an account name, press <F5> again.    Then
fill in the rest of the data fields.

Note:    When you click the Add button to put the record into your database, WinCharging 
automatically substitutes the account name for the account number.

Of course, after you've created some receipts records, you'll want to use WinCharging to 
monitor your credit limits and target amounts, create charts, and display reports.    While 
these adventures can be interesting, even fun, the day comes when the bill arrives.

Up next ... Pay Bills!

Go ahead and enter your receipts now.    If you feel like clicking around a little bit 
in WinCharging afterwards, feel free.    Then resume reading this Help file.    Not to
worry, you're almost finished!



Apply to Target Switch

If checked, WinCharging includes the amount of this record when calculating how close you 
are to your target amount.



New Receipts Form

Press <F5> to switch between displaying account names and numbers.



Card ID

Many card issuers number the cards of an account.    Use those numbers to identify the 
cardholder of a purchase.



Credit Card Names

If you have more than one account, click the down arrow on the right to open the credit card
name list.    Highlight the account name and press <enter>.    (To view the account numbers,
press <F5>.)



Activity

A credit card receipt is either a charge or a refund.    Click the appropriate option button.



Add Button

Click the Add button to put the information on the form into a record in your database.



Close Button

Closes the New Receipts form.



Reset Button

Resets all of the fields on the form to their original values.



Pay Bills
Pay Bills looks much like New Receipts, but it can only be opened for a specific account.    
The easiest way to use it is with the arrow keys.    They allow you to move the focus among 
any of the buttons along the top of the form.

At the end of every billing period, each of your credit card issuers sends you a report based 
on that period's account activity.    This report is called your billing statement.

With your billing statement in hand, compare the record that appears in Pay Bills with the 
items listed on your billing statement.    (Pay Bills displays your outstanding records in date 
order.)

If the record appears on your statement and the amount and other data are correct, set the 
focus on Paid and press <enter>.    If the record doesn't appear on your billing statement, 
put the focus on the Not Paid button and press <enter>.

When you press the Paid button, Pay Bills marks the record paid.    If you press Not Paid, the 
record is marked unpaid.    In either event, Pay Bills displays the opened account's next 
outstanding record.

Note:    You can move forward and backward through the unpaid records by using the directional 
buttons located on either side of the Paid/Not Paid buttons.    If you inadvertently mark a record 
paid, for example, click the backward pointing button once and then click the Not Paid button.

You can change any of the information in the record.    To do so, place the focus on the field 
whose contents you wish to change by clicking it with the mouse.    You can also tab to the 
field.    When you're finished making changes, click either the Paid or Not Paid button.

If you'd like to try this window now, go back to WinCharging and click one of the 
Pay Bills buttons on the left side of Outstanding Amounts.    Use the directional 
keys to view your records.    When you come back ...

Many people prefer to use grids when working with multiple records instead of a single 
record display like Pay Bills.    If you're one of them, you'll find WinCharging most 
accommodating with its Details of Outstanding Bills window, described next.





Close Button

Closes the Pay Bills form.



Delete Button

Deletes the displayed record.    Confirmation is required.    The Delete button is disabled if 
any of the other windows that access the charge receipts database is open concurrently.



Forward and Backward Buttons

Allow you to page through the list of outstanding bills for the current (opened) account.



Not Paid Button

Marks a record unpaid and causes Pay Bills to advance to the next record.



Paid Button

Marks a record paid and causes Pay Bills to advance to the next record.



Details of Outstanding Bills
Details of Outstanding Bills has a grid structure that is perfectly suited for quickly editing 
fields in multiple records.    And since you generally work only with your outstanding records, 
this form is usually the only one you'll need to use to declare records paid or make changes.

As you can see in the above example, the opened account has four outstanding records.    To 
mark all of them paid at once, simply double-click the Paid column heading.    Click on the 
various parts of the display for more information about the form.

Like Pay Bills, Details of Outstanding Bills provides ready access to an account's outstanding 
records.    Details of Outstanding Bills does not allow you to change account names in a 
record, however.    You must use Pay Bills or Grid Work (which is not discussed in this 
introduction) to do that.

To give Details of Outstanding Bills a test drive,    return to WinCharging and 
double-click an account's outstanding amount or open the form from the Launch 
Menu.    Don't be gone long!

Pay Bills and Details of Outstanding Bills are for cardholders who pay their accounts' new 
balances in full every month.      However, if you're one of the millions of people who pay off 
their outstanding amounts over time, the next chapter is for you.



Record Numbers

To delete a record, double-click its record number.    If the Delete button is disabled, you 
cannot use the delete function.



Details of Outstanding Bills Form

Double-click the form to switch between standard and bold type in the grid.



Minimizing Details of Outstanding Bills

Double-click the "Rec #" column heading to minimize the form.



Paid (Pd) Column Heading

Double-click this heading to mark all of the displayed records paid.    This action must be 
performed before making any other changes.



Activity Column

Double-click a record's activity cell to change it from C (for charge) to R (for refund).



Paid Column

Double-click a record's Paid cell to switch between Y for yes (paid) and N for no (not paid).



Target Column

Double-click a record's Target cell to switch between Y (meaning yes, the amount applies 
toward the target) and N (for no, it does not apply).



Close Button

Closes the Details of Outstanding Bills form.



Delete Button

Initiates the delete function for the selected record.    It is disabled if any other window that 
can access the charge receipts database is open.



Buying Time
Many cardholders give themselves loans by paying off the items they purchased with credit 
cards over time.    These people need to use WinCharging's pay down method of accounting.

The pay down method lets you tell WinCharging how much you're paying against the 
outstanding amount of an account.    You use the Establish PDM Account form, shown on the 
right, to change a standard account to a PDM.

To start the process, open the Launch Menu and highlight Pay Down Method.    Then select 
the Establish PDM command.

If you have more than one account, you'll have to tell WinCharging which account is to be 
set up as a PDM.    WinCharging then displays the outstanding amount for that account and a
warning, as shown above.

Once the account is converted, you continue to enter your charge receipts records the same 
way you did when it was a standard account.    The only difference with a PDM account is 
that you no longer mark its individual records paid.    WinCharging effectively marks them 
paid as you create them and simply increases the amount of the loan you have outstanding.

Note:    For all PDM accounts, it is recommended that you enter your finance charges and 
payments as New Receipts charges and refunds, respectively.

For a full description of the PDM accounting method, refer to WinCharging's standard Help 
file.    Click the Search button and enter the phrase "pay down method".



Amount Field

Shows the outstanding amount of an account that is about to be switched to the pay down 
method of accounting.



Cancel Button

Cancels the Establish PDM function and closes the window.



Enter Button

Changes the displayed account from a standard type to a pay down method account.



In Summary
You're finished!    Please remember that the MeFirst! Help file is just the beginning.    The 
WinCharging Help file is filled with detailed information on every facet of the program.

As with MeFirst!, the WinCharging Help file can be read like a book.    Simply use the browse 
buttons at the top of the Help window.    If you're puzzled about a specific word or phrase, 
click on the Help window's Search button.    The Search function is fast and easy to use.

On those rare occasions when you can't seem to find what you want using Search, click the 
Contents button.    In the Contents topic of WinCharging's main Help file you'll find a line 
called WinCharging Help Index.    Click that line to go to the Index topic.

The Help Index contains almost every phrase, function, and form used in WinCharging.    It's 
listed in alphabetical order, so all you have to do is click on the line you're interested in.

Finally, there is technical support.    For tech support information, open WinCharging's Help 
Menu and click on the Technical Support command.

Important Reasons to Buy WinCharging!

1    It can help you make money.    If you use credit cards to earn rebates or get cash back,
WinCharging can tell you when you've earned the maximum on one card so you can 
switch to another income-producing or rebate-earning card.    That way your cards are 
always working for you.

2    While your credit cards might be safe, your account numbers might not be.    With the 
increase in mail theft, credit card users must make certain that the charges they are 
paying for are, in fact, theirs. WinCharging makes it easy.

3    WinCharging can help you get a handle on you how you're spending your hard-earned 
money.

4    Tax time can be less tedious, at least as far as your credit card expenditures are 
concerned.    WinCharging prints all sorts of reports, including Tax Summaries.

5    WinCharging holds a Four-Star rating from Ziff-Davis and was a runner-up in the 1995 
Ziff-Davis Shareware Awards contest.

6    Additional features!    With the registered (deluxe) edition, you can:    create multiple 
databases; password protect and encrypt your databases; and archive your databases.

When you register you get the latest version of WinCharging, a backup floppy disk, a floppy 
disk carrying case, 50% off on other MLR programs, and update/upgrade notices.    All 
absolutely free.

Thank you for taking the time to read the MeFirst! Help file.    If you have 
questions or comments about WinCharging, please feel free to contact My Little 
Realm Enterprises.    You'll find the phone and email numbers as well as the 
address under WinCharging's Help menu.    Just click on Technical Support.






